SAP Business One 10.0
Release Highlights

Global Partner Enablement, SAP Business One
July, 2023

Note to Customers, Partners, and Others
This material may not be published on other platforms or websites outside SAP.
Please note the copyright "No part of this publication may be reproduced or transmitted in
any form or for any purpose without the express permission of SAP SE...".
To reference the latest material please use this link.
Disclaimer

The information in this presentation is confidential and proprietary to SAP and may not be disclosed without the permission of SAP. Except for your obligation to protect confidential information, this presentation is not subject to your license agreement or any other service or subscription agreement with SAP. SAP has no obligation to pursue any course of business outlined in this presentation or any related document, or to develop or release any functionality mentioned therein.

This presentation, or any related document and SAP’s strategy and possible future developments, products and or platforms directions and functionality are all subject to change and may be changed by SAP at any time for any reason without notice. The information in this presentation is not a commitment, promise or legal obligation to deliver any material, code or functionality. This presentation is provided without a warranty of any kind, either express or implied, including but not limited to, the implied warranties of merchantability, fitness for a particular purpose, or non-infringement. This presentation is for informational purposes and may not be incorporated into a contract. SAP assumes no responsibility for errors or omissions in this presentation, except if such damages were caused by SAP’s intentional or gross negligence.

All forward-looking statements are subject to various risks and uncertainties that could cause actual results to differ materially from expectations. Readers are cautioned not to place undue reliance on these forward-looking statements, which speak only as of their dates, and they should not be relied upon in making purchasing decisions.
SAP Business One 10.0 Enhancements (1/4)

- SAP Note 2826255 - Central Note for SAP Business One 10.0
- SAP Note 2826199 - Central Note for SAP Business One 10.0, version for SAP HANA
- Learn about the Web Client [here](#)
- For latest features check the [What's New in SAP Business One 10.0 MS SQL | SAP HANA](#)
- SAP Business One [YouTube](#)

### Web Client for SAP Business One
- Enhance Delivered Objects
- Support Message Preferences
- Enhancements in Outgoing SnB/Bin Location Selection
- Support BP Catalog Number
- Support Purchase Quotation & Purchase Order
- Service Module
- Support Goods Receipt PO & A/P Invoice
- Support Payments
- Time Sheet

### User-Defined Queries (UDQs)
- Analytics Enhancements
- Outlook 365 Enhancements
- **MS Teams** - Access Web Client List View & Detailed View
- **MS Teams** - Access Dashboards & Charts

### Extensibility Support
- Configuration App
- Support Goods Return & A/P Credit Memo
- Support Alternative Items
- Support Goods Issue
SAP Business One 10.0 Enhancements (2/4)

**Web Client** – cont.

Support Journal Entry
Support Equipment Card
Support Approval Process for Approvers

**Extensibility** – Enhancements

Outlook 365 Integration Enhancements
Single Sign-On for Web Client and Extensions
Support “Read Only” Mode
“Horizon” Skin
Support “Text” and “Subtotal” line types
Support document Opening & Closing remarks
Packing Slips in Deliveries and A/R Invoices
Assign Distribution Rules in Sales and Purchasing Document Lines
Attachments Tab in Business Partner Master Data

Approval Decisions Apps Support Additional Sales and Purchasing Docs
Email up to 20 selected records
Support Return Request, Purchase Request & Goods Return Request
Support A/P Reserve Invoice
Support Goods Receipt
Support Inventory Counting
Support Bill of Material
Support Issue for & Receipt from Production
Support Service Contract
Analytics Enhancements

**Extensibility** - Support API Views for All Analytics Views
**Extensibility** - Support User-Defined Field as a Check Box Type
SAP Business One 10.0 Enhancements (3/4)

**Administration**
- Support Expiration Date Enhancements
- In Document Printing
- Referenced Document Enhancements
- Support Attachments Tab in Additional Objects
- Increased Field Lengths
- Enhancements in Approval Process
- New Overview Window: Alerts Management
- Tab-Level Authorizations in Master Data
- Product Documentation Moved to SAP Help Portal
- Messages/Alerts Cleanup Tools
- Manage Change Log for System Setups
- Data Archive Simplification

**Usability**
- New Skin Style
- Enhanced User Interface
- Alignment of Form Behavior
- User Name in License & Add-On Administration

**Financial Management**
- Drill Down to G/L Accounts in Financial Reports
- Posting Periods Enhancements
- Extend Journal Entry Remarks to 254 Characters and Increase Length of Ref.3 Fields
- Financial Management Enhancements
- Period End Closing - Journal Entry Series
- Fixed Assets Enhancement

**Localization**
- New UK (Brexit) Localization
- EU - One Stop Shop Enhancement
- Mexico - Electronic Invoice CFDI 4.0 - eDoc
- India Localization Enhancements
- Japan - Qualified Invoice Method
- Argentina - Withholding Tax (Perception) in the Automatic Credit Memo
- EU - Items Country of Origin Tracing
- US - Tax Service with Avalara’s Tax Rates by Address
- BR - API Tax Enhancements - Service Layer & DI API
- FR - Legal Compliance Enhancements
- MX - CFDI 4.0 Enhancements
# SAP Business One 10.0 Enhancements (4/4)

## Sales | Purchasing | Service

- Backorder Report Enhancements
- Printing Service Calls & Contracts
- Hide Blank Lines in Addresses
- Add Button Extended in Marketing Documents
- Enhanced Open Items List Report
- EU PEPPOL E-Invoicing
- SAP Business One Sales and Service Mobile Apps
  - “Confirmed” Checkbox in Sales and Purchase quotations
  - “Move Up” and “Move Down” buttons in sales and purchasing documents to change lines sequence

## Project Management

- Interactive Gantt Chart

## Inventory | Distribution

- Serial & Batch Numbers Management
- Ability to change UoM Group of an item

## Production

- Bill of Materials (BoM) Description Enhancements
- Drill Down from BoM to Item Master Data
- Production Enhancements

## Platform | Extensibility

- Service Layer Enabled for Microsoft SQL Server
- Service Layer Configuration UI
- Formatted Search Supports Multiple Triggers
- Extend UDF Support to Additional Objects
- Microsoft Office 365 Integration
- 64-bit Support Only
- GateKeeper (Browser Access) Service
- DI API | Service Layer | Platform | Integration Framework Enhancements
- Extensibility Enhancements
- Identity and Authentication Management (IAM)
Web Client
SAP Business One 10.0 (MS SQL)  
SAP Business One 10.0, version for SAP HANA  

PL02 Update
The Web Client* is based on SAP Fiori design principles encapsulating SAP Business One core processes and business logic alongside an advanced user experience.

- Focused on creation, processing and updating of Sales Quotations, Sales Orders, A/R Deliveries, and A/R Invoices (PL01)
- List views for purchasing documents (PL02)
- Supports creation and update of Items, Business Partners, and Activities
- The Web Client provides some sophisticated analytic charting capabilities
- For optimized user experience launch the Web Client in either a desktop computer or tablet, using the Google Chrome or Firefox web browser. The Web Client can also be launched directly from the regular SAP Business One desktop application.

* The Web Client delivered with SAP Business One 10.0 PL02 is supported by all SAP Business One localizations. Brazil and India in view mode only.

Learn about the Web Client here
For latest features check the What's New document
Web Client for SAP Business One

FP2105 Update

- Enhance delivered objects (Business Partner, Items, Activity, Sales Quotation, Sales Order, Delivery, and Invoice)
- Extend sales support (Return, A/R Credit Memo, and A/R Reserve invoice)
- Support of outgoing serial and batch numbers/bin location selection
- Extend localization support
- Support CRM
- Enhance Analytical capabilities
- Support Microsoft 365 (Excel)
- Extensibility support (URL mashup, Fiori/HTML5 app support)
- Web Assistant Adoption
Web Client - Enhance Delivered Objects

- Business Partner Master Data Support
- Checks balance for customers
- Additional fields and columns are added to the Opportunities list view for more flexible and efficient filtering options
- Cancelling A/R Credit Memo via list view is supported
- Enable upload BP image using camera
Web Client - Support Message Preferences

- Message Preferences form is added to Settings section under the user area, enabling users to review their message preferences and change it as required:
  - Display a message that is currently not display
  - Change the answer to be applied in case a message is not displayed
- The settings done on the Web client apply to the same messages on the regular client and vice versa
Web Client - Enhancements in Outgoing SnB/Bin Location Selection

- Auto select button is added to lists of bin locations and serial and batch numbers selection to increase efficiency
- The Batch/Serial Numbers and Bin Location columns are editable, enabling the user to start typing directly the required value and the auto-suggest feature lists the most suitable values accordingly
A new app for Business Partner Catalog Number is added under Business Partners module

Here you can view, define, update and remove catalog numbers grouped by business partner, as well as set default and duplicate selected items

Using the filter-bar you can filter the list for better efficiency

Like in other lists, you can export BP catalog numbers to Excel

The "BP Catalog Number" button added to business partner and item master data headers opens the list of catalog numbers defined for the given business partner or item
Web Client - Support Purchase Quotation & Purchase Order

- New apps for creating and processing Purchase Quotation and Purchase Order are available.
- In addition, the Purchase Quotations and Purchase Orders apps are enhanced to support:
  - View, process and create Purchase Quotations and Purchase Orders
  - Batch operations for selected records—such as Close and Cancel
The Service module in the Web client enables you to create and process service calls and solutions.

The Service Calls and Solution Knowledge Base list views provide you comprehensive overview and enable you to generate respective reports.

Enhanced user-interface design enables the user to view selected solution side-by-side the respective service call, gaining the benefit of having all information in one place.
Web Client - Enhance Analytic Capabilities

FP2108 Update

- Card view option is added to all list views, including UDOs & UDTs
- The Card View enables you to create sets of analytical cards for a given object using dedicated editor and save it as view for future use
Web Client - Extensibility Support

- Ability to package web applications with VS CODE (URL mashups, Apps), Based on Fiori/Angular/React/Vue frameworks
- Support Tiles Image
- UI-API Framework - Internal prep
Web Client - Enhance Delivered Objects

- Support “Reset” in Home Page Groups
- You can re-position rows in Sales & Purchasing Documents in “Create” mode, and in “Edit” mode in Quotations and Orders
- Serial/Batch and Bin Location Auto-Allocation For Outbound Transaction
- The “Notification Center” is enhanced to display notifications when a service call is assigned to you as a user or as a technician
- Service Calls list view is enhanced to support “close” and “reopen” of single/multiple service calls and the filter bar is enriched with additional fields
- “Business Partner Addresses” view is added to the Manage Business Partners list view
- Business Card scanning is supported
- List views support copying only part of the document rows to target document
- Draft watermark is supported for draft preview
The apps “Goods Receipt POs” and “A/P Invoices” enable you to manage, process and create Goods Receipt POs and A/P invoices.

The apps “Create Goods Receipt PO” and “Create A/P Invoice” enable you to launch the respective document form in “Add” mode to efficiently create new documents.
Web Client - Support Payments

- Incoming and Outgoing Payments apps are available, enabling you to manage, create, and cancel payments.
- You can create payments for business partners or accounts – dedicated apps provide quick launch of the required form.
- You can visualize the payment mean related columns in the List View and include them for filtering options.
- Supported payment means are cash and bank transfer.
New apps “Time Sheets” and “Create Time Sheet” are available

You can view, create and update time sheets for users, employees, or external contractors
Web Client - User-Defined Queries (UDQs)

- The “User-Defined Queries” app enables you to create, edit, preview, generate, and remove user-defined queries without parameters (update queries are not supported).
- You can open the queries in a list view, apply filters, manage views, and save it as a tile, same as any other list view.
- The queries can be used as “Data Source” when editing or designing analytic cards in Overview pages.
- User-Defined Queries created in the Web Client will be available also in the Query Manager of the B1 client.
Web Client - Analytics Enhancements

- New options are added to the date picker to allow more flexibility of date ranges:
  - Last X posting periods
  - Next X posting periods
- The “Date Offset” calculation is enhanced to support specific month of the year e.g. January, or a day of the week, e.g. Monday. In addition, the expressions “PostingPeriod:Begin” and “PostingPeriod:End” are supported
Web Client - Outlook 365 Enhancements

- New control of sending e-mail directly from sales documents in Web Client through linked Microsoft 365 Outlook account
- User may review final e-mail before it is finally sent through linked Outlook 365 account.
- Word file with exported document is attached to such e-mail
- Default text and subject of an e-mail message can be set at Print Preferences
**Requirement**
- Different roles in a sales team, for example, sales managers, marketers, and pre-sales, can view all Web Client views directly in MS Teams to improve collaboration across departments and systems while working on the same business potentials.

**Capabilities**
- Add any list view & detailed view to Tab View of MS Teams
- View all authorized view in MS Teams

**Benefits for Customers**
- Collaborate and manage work easily without changing systems
- Increase productivity and work efficiency
**Public Requirement**

▪ Users can view Dashboards & Charts directly in MS Teams to improve collaboration across departments and systems while working on the same business topic.

**Capabilities**

▪ Add Dashboards & Charts in Tab View of MS Teams
▪ View all authorized Dashboards & Charts in MS Teams

**Benefits for Customers**

▪ Collaborate and manage work easily without changing systems
▪ Increase productivity and work efficiency
Web Client - Extensibility Support

- Support displaying KPIs on extension tiles
- Support MS Blazor by VSCode Template Wizard
- Support APIs for new views
- Online help enhancements
Web Client - Enhance Delivered Objects

- Relationship Map is enhanced to support additional objects, e.g. Payments
- Attachment Management is added to marketing documents
- Support Bar Code
- Business Card scanning is available for vendors
- Incoming & Outgoing Payments are enhanced to support Bank Charges, Invoice + Payment, Checks and Credit Cards payment means, and payment drafts
- Notification Center is enhanced to push notifications for scheduled service calls according to service call’s priority
The Configuration app is available under the Administration group, allowing authorized users to edit and define new values for part of the objects available in the Web Client.

The setup dialogs are grouped by modules, e.g. CRM, Business Partners, etc.

The setup dialogs are also available from within the respective objects by choosing the option “Define New” in the relevant field.
The apps “Goods Returns” and “A/P Credit Memos” enable you to manage, process and create goods returns and A/P credit memos.

The apps “Create Goods Return” and “Create A/P Credit Memo” enable you to launch the respective document form in “Add” mode to efficiently create new documents.
The Alternative Items app under Item Management group enables you to define, update, and remove alternative items.

When creating marketing documents for items, you can add to the table the Alternative Items column where you can open a dedicated dialog for choosing the required alternative item from the relevant warehouse.
Web Client - Support Goods Issue

- Under the Inventory Transactions group the Goods Issues and Create Goods Issue apps are available
- You can manage and process existing goods issues as well as creating new ones and manage goods issues drafts
The Journal Entries and Create Journal Entry apps are added under the Accounting module, allowing you to manage, process, and manually create journal entries.

In the Journal Entries app you may find a predefined view for displaying the reverse transactions set for today’s date.
Web Client - Support Equipment Card

- Equipment Cards and Create Equipment Card apps are added under the Service module, enabling you to manage, and create equipment cards.
- Predefined views provide you out of the box the list of active equipment cards and list of all equipment cards in the company database.
Web Client - Support Approval Process for Approvers

- The Approval Decision app is added to the various document groups, allowing authorizers to review the documents pending for approval, approve, reject, or directly add them.
- The notification center is enhanced to display notifications of approval requests.
Web Client - Analytics Enhancements

- The Linked List Views app enables you to link views from all List Views and General Overview views to all Master Data and Document objects, by setting additional filter conditions.
- The Import and Export Views app enables to export & import user-defined views, pre-defined views, links to view and User-Defined Queries, to and from any company database.
- The User-Defined Queries app is enhanced to support inclusion of SQL views and HANA calculation views within a SQL statement in addition to choose from list ability from list of SQL commands, database tables, SQL Views and HANA Calculation Views.
- With FP 2202 you can duplicate selected user-defined query for more efficient query creation process.
The “Display Menu” column enables you to choose which user-defined tables should be displayed under the User-Defined Tables menu entry and home page group in the Web Client.
Web Client - Outlook 365 Integration Enhancements

- Choose Email Option is added to the marketing documents detailed view: four options are added,
- Choose Email Option is added to the marketing documents View List: three options are added
- For the PDF attachment default CR Layout is used,
- E-mails Log and document status are updated when send mail to customer.
- SAP Notes: 3142946, 3143036, 3143073.
New “Horizon” skin is available in the “Settings” dialog, under “Appearance”, on the “Theme” tab. The new skin in the Web Client adopts the color scheme and tile style of the Horizon visual theme for SAP Fiori.
You can add, update, view, and preview packing slips in deliveries and A/R invoices.

You can assign and view distribution rules for cost centers in sales and purchasing document lines.

The relationship map is enhanced to display payments and documents created via the Procurement Confirmation Wizard.

Attachments tab in Business Partner Master Data supports display, remove and adding attachments, also by Drag & Drop.

Purchase Requests, Goods Return Requests, Goods Receipts, and Outgoing Payments are supported by the “Approval Decisions" apps in the respective groups.

A new Email option enables you to send by mail up to 20 selected records.
“Return Requests” app and “Create Return Request” app are available in the “Sales” group, supporting the creation, processing, review and analysis of return request documents, as well as viewing the respective relationship map.
“Purchase Requests” app and “Create Purchase Request” app are available in the “Purchasing” group, supporting the creation, processing, review and analysis of purchase requests, as well as viewing the respective relationship map.
“Goods Return Requests” app and “Create Goods Return Request” app are available in the “Purchasing” group, supporting the creation, processing, review and analysis of goods return requests, as well as viewing the respective relationship map.
“A/P Reserve Invoices” app and “Create A/P Reserve Invoice” app are available in the “Purchasing” group, supporting the creation, processing, review and analysis of A/P reserve invoices, as well as viewing the respective relationship map.
“Goods Receipts” app and “Create Goods Receipt” app are available in the “Inventory Transactions” group, supporting the creation, processing, review and analysis of goods receipts, as well as viewing the respective relationship map.
“Inventory Counting Transactions” app and “Create Inventory Counting” app are available under “Inventory Transactions” group, enabling you to review and close single or multiple inventory counting transactions as well as create and perform new inventory counting transactions by a single or multiple counters.
Web Client - Support Bill of Material

“Bills of Materials” and “Create Bill of Materials” apps are available under the “Production” group, supporting the creation, processing, review and analysis of bills of materials, as well as viewing bill of materials relationship map in various visualizations.
“Receipts from Production” and “Create Receipt from Production” apps, and “Issues for Production” and “Create Issue for Production” apps are available under the “Production” group, supporting the creation, processing, review and analysis of receipts from production and issues for production.

The app “Production Orders” is available under the “Production” group allowing you to view, filter and analyze existing production orders.
The apps “Service Contracts” and “Create Service Contract” are available under the “Service” group, enabling you to review, create and approve single or multiple service contracts.

You can create new service contract manually or based on predefined template.
Web Client - Analytics Enhancements

- When creating or editing active user-defined queries, new setting enables you to display a tile that launches the query in the Analytics group on the Home page
- “Views” menu is now available in Edit and Create modes, enabling you to launch lined views, manage existing views and define new ones
Web Client - Extensibility Enhancements

- Support API Views for all analytics views - possible to have a link from Tile Extension to any Analytics view
- Support User-Defined Field as a Check Box type for both desktop client & Web client
Web Client - Usability Enhancements

- Display KPIs on saved tiles
- User actions menu
- Authorization to manage public linked list views
Web Client - Enhance Delivered Objects

- Distribution rules in journal entries
- Add contact person to existing Business Partner’s via card scanning
- Support predefined texts
- Office 365 enhancements
  - Share option in Activities and Return Requests
  - Allow to define new email groups
- Inventory counting enhancements
  - Close document and rows
  - Counting by multiple UoMs
  - Highlight rows and fields with variance percentage
  - Support user-defined field sorting and filtering in Inventory counting detailed view
  - Support distribution rules
Web Client - Enhance Marketing Documents

- “Text” and “Subtotal” line types
- Support adding table rows
- Opening and closing remarks
- Adding Items details column with predefined texts
- Consolidating business partner details
- Support A/P reserve invoices in approval process, and drafts management
- Support linking paid down payment requests/invoices
Web Client - Analytics Enhancements

- Support read-only mode
- Link management enhancements in linked list views
- Creating conditional links for user-defined query fields

FP2305 Update
Administration
SAP Business One 10.0
Support Expiration Date

Feature

- The information Support Expiration Date is shown in the About SAP Business One window
- Version Name in About window is changed to quarterly release cycle (FP2008)
  See SAP Note 2957553

Benefit

- Simplifies support by having necessary information available in one screen
Enhancements in Document Printing

Feature

- The selection criteria for document printing is enriched with additional options according to the selected document type
- Form Settings window is added to the “Print <document>” window allowing the user to customize the column display
- The “Print <document>” window now supports table sorting and filtering

Benefit

- The enhanced selection criteria enables you to optimize batch printing
- Increased usability and productivity especially when printing a high number of documents
Referenced Document Enhancements

Feature

- You are now able to reference documents in Checks For Payment, Purchase Request, Goods Receipt & Issue, Inventory Transfer Request, and Inventory Transfer.

- Numeric indication for number of referenced documents.

- Automatic referenced document creation from applicable marketing documents.

- Recurring Postings can be referenced to a single document. This document contains a reference to each recurring posting created. The referenced by tab displays then the cross referencing to the recurring posting itself.

- Module-sorted list of documents to reference.

- Document Referencing is available for Incoming and Outgoing Payments, Inventory Revaluation, Inventory Counting, and Inventory Posting (FP2008) - SAP Note 2945089.

- When duplicating a document, a reference between the original and duplicated document can be created (FP2011) - SAP Note 2958941.

Benefit

- Extended coverage of referenced documents across SAP Business One modules.

- Better visibility of when documents are referenced.
Support Attachments Tab in Additional Objects

Feature

- The Attachments Tab is now available in *Inventory Opening Balance*, *Inventory Counting*, *Inventory Posting*, *Incoming Payments*, *Outgoing Payments*, *Check for Payments*, *Deposit*, *Journal Entry*, *Production Order*, and *Time Sheet*

- *Due to the addition of the Attachments tab, the Contents tab now holds the original details of the form/General tab*

Benefit

- Support managing attachments for additional objects and streamline system behavior
**Feature**

- *Customer Group Name* and *Supplier Group Name* may contain up to 100 characters.
- The *Item Group Name* also supports 100 characters.
- The length of the *Item Description* field in the *Item Master Data* window is 200 characters ([FP2008](#)).
  
  See SAP Note [2949632](#).
- The field length of *Industry Name* is 40 characters and of *Industry Description* is 120 characters ([FP2008](#)).
  
  See SAP Note [2931333](#).

**Benefit**

- More flexibility for the values entered in these fields.
- Standardization of product field definitions.
New Overview Window: Alerts Management
SAP Note 2945182

Feature
- New window *Alerts Management* available
- Overview of system and user alerts
- Filter option
- *Actions* button to create:
  - New user alerts
  - Set alerts to active or inactive
  - Remove alerts

Benefit
- Simplifies alerts management
- Better overview on existing alerts
Enhancements in Approval Process

**Feature**
- New setting enables approvers to update draft document in Pending status
- **Last Updated By** and **Last Updated On** fields are now available within the Request for Generation Approval form
- **Approval Status Report** now contains **Draft Updated By**, **Draft Update Date**, **Draft Update Time**, and **Draft Remarks** fields
- Both the authorizer and the originator can add the document for approval
- Substitute Authorizers for approval templates are enabled when the authorizer is out of office (FP2105)

**Benefit**
- Minimizes unnecessary back and forth between authorizer and originator
- Simplifies approval procedures and adds even more flexibility
Tab-Level Authorizations in Master Data Records

Feature
- Different authorizations can be granted to different tabs in Business Partner Master Data and Item Master Data
- If a user has no authorization for a given tab, this tab will be automatically hidden

Benefit
- Enables the granting of more accurate authorizations to each user, based on tasks and responsibilities
- Helps to prevent human errors and increases data protection
- Increases productivity
Product documentation shipment methodology is enhanced. The documentation deliverables in the Documentation folder have moved to SAP Help Portal where you can access the latest (and previous) product documentation.
Business Process Enhancements

- Attachments tab is added to Bill of Materials along side a new setting to determine whether to copy attachments from BoM to Production Order. In addition, new setting that enables to determine whether to overwrite attachments with same file name is available.
- Blanket Agreement Fulfillment Report is enhanced to display four new columns: Cumulative Ordered Quantity / Amount and Total Open Quantity / Amount.
- The Query Manager is enhanced to support renaming of user queries. In addition, you can edit a user query without executing it, just by using the “Edit” option in the context menu.
- Support “Change Log” for teams update in Employee Master Data.
- “Telephone” field length is increased to 50 characters.
- “Foreign Name” field length in Item Master Data is increased to 200 characters.
Business Process Enhancements

- Display Price List No. & Name in marketing documents rows
- Manage Change Log for Exchange Rate & Indexes table and additional setup entities
- Increase number of Authorization Groups for Document Numbering and Price Lists
- Introduce new authorizations for creating and removing Time Sheet
- Add keyboard shortcut for Refresh Button
“Messages/Alerts Cleanup” and “My Messages/Alerts Cleanup” tools enable authorized users to clear messages and alerts within a defined date range.

New settings in company level and user level enable you to define the number of latest records to be displayed in the “Messages/Alerts Overview” window.

“Authorization” and “License” buttons enable super users a direct access to the respective windows.

Password options and security are enhanced by supporting passwords with up to 128 characters.
Administration Enhancements

- Managing change log for system setups
- Data archive simplification
- Password policy requirements for new installations
- Approval process enhancements
  - Approving and Rejecting Draft Marketing Documents
  - Displaying and Printing Draft Key Numbers

FP2305 Update
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Log Window Enhancements</td>
<td>New columns “Created On/At” and “Updated On/At” are added to the Change Log window to see the specific date and time. SAP Note 2957436 (FP2008)</td>
<td>All</td>
</tr>
<tr>
<td>Manually Entering Paths</td>
<td>Paths can be manually entered or pasted on the Path tab in the General Settings window. SAP Note 2949641 (FP2008)</td>
<td>All</td>
</tr>
<tr>
<td>Shipping Types Deactivation</td>
<td>New checkbox Active is available in the Shipping Types window under Administration → Setup → Inventory → Shipping Types to activate or deactivate shipping types. SAP Note 2950719 (FP2008)</td>
<td>All</td>
</tr>
</tbody>
</table>
**Feature** | **Description** | **Localization**
--- | --- | ---
**Warning Message When Choosing ‘Personal Blocking’**<br>When choosing *Personal Data Blocking* in the *Personal Data Management Wizard* a warning message is displayed if the *BP Balance* amount is not zero.<br>SAP Note 2946064 (FP2011) | All

**Authorization for 'Copy Table' Function**<br>In the *General Authorizations* a new authorization *Copy Table* is available with *Full Authorization* and *No Authorization.*<br>In new installations and after upgrades the default setting for the *Copy Table* authorization is *Full Authorization*; for new users, *No Authorization* is selected by default.<br>SAP Note 2970937 (FP2011) | All

**Configure License Balloon Appearance**<br>A new checkbox *Show License Information at Startup* is added to the *Users – Setup* window -> *Services* tab to set whether the license balloon will be displayed after logging in.<br>The checkbox is reset to default (balloon is displayed):<br>- Every 3 months / 90 days<br>- When upgrading to a higher patch or release<br>SAP Note 2970959 (FP2011) | All
### Feature

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Under <strong>Administration → System Initialization → Document Settings → Per Document</strong> tab, select a sales or purchasing document type, under <strong>When Duplicated Customer Reference No. Occurs:</strong> When selecting <strong>Warning Only</strong> or <strong>Block Release/Receipt</strong> the following options are available:</td>
</tr>
<tr>
<td><strong>- Check for Duplicate Under</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>- Check for Duplicate in Current Fiscal Year Only</strong></td>
</tr>
</tbody>
</table>

SAP Note [2970936 (FP2011)](https://support.sap.com/)

### Localization

All
# Administration

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
</table>
| Authorization to Remove Opportunity        | Authorization is required for new users to remove an opportunity. Assign authorization under Administration -> System Initialization -> Authorizations -> General Authorizations -> Opportunities -> Special Opportunity Authorizations -> Remove Opportunity  
  SAP Note [2985725](FP2102)                  | All                                                      |
| Authorization to View Other Users’ Payment Drafts in Payments Draft Report | Regular users can view incoming and outgoing payment drafts created by other users respectively, if the following two authorizations are given:  
  - View Incoming Payment Drafts Created by Other Users  
  - View Outgoing Payment Drafts Created by Other Users  
  Define Authorizations under Administration -> System Initialization -> Authorizations -> General Authorizations -> Banking -> Outgoing Payments -> Payments Drafts Report  
  SAP Note [2990653](FP2102)                  | All                                                      |
| Copy Selected Forms Between Users          | An admin user is able to copy selected forms' settings from one user to another.  
  SAP Note [2979530](FP2102)                  | All                                                      |
### Feature

**Access to Change Log for User with Read-Only Authorization for Specific Object**

<table>
<thead>
<tr>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users with full authorizations for <em>Change Log</em> and read-only authorizations for the following documents can view their change logs:</td>
<td>All</td>
</tr>
<tr>
<td>- Sales and purchasing documents</td>
<td></td>
</tr>
<tr>
<td>- Journal Entries</td>
<td></td>
</tr>
<tr>
<td>- Goods Issues, Goods Receipts, Receipts from Production, and Issues for Production</td>
<td></td>
</tr>
<tr>
<td>- Inventory Transfers and Inventory Transfer Requests</td>
<td></td>
</tr>
<tr>
<td>- Inventory Opening Balances, Inventory Counting, and Inventory Postings</td>
<td></td>
</tr>
<tr>
<td>- Incoming Payments and Outgoing Payments</td>
<td></td>
</tr>
<tr>
<td>SAP Note 2303812 (FP2102)</td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| User Codes in Change Log and Differences | News fields and columns are available for the Change Log (Tools -> Change Log) and Differences to display unique information listed by user code:  
- Updated By – User Code  
- Created By – User Code  
SAP Note [3031630](FP2105) | All |
Usability
SAP Business One 10.0
New Skin Style - Belize Deep

**Feature**

- New skin style “Belize Deep” is added to SAP Business One 10.0, version for SAP HANA.
- Inspired by the SAP Fiori design and following the Web Client look & feel.
- Currently available when using the Fiori-Style Cockpit.
- 4K monitors supported when using the Belize Deep skin style.

**Benefit**

- Modern and fresh look and feel.
- Harmonized user-experience for those who work with both SAP Business One and the Web Client.
Enhanced User Interface

Feature
- New icon and menu option under the View menu enables the showing or hiding of the toolbar
- Users can enlarge working area by hiding the toolbar
- The company name and user name are clearly displayed at the top center of SAP Business One window; Click it to open the “Choose Company” window directly

Benefit
- Information about current company and logged-on user is displayed clearly
- Switching between company databases and users is one-click away
Alignment of Form Behavior

Feature

- Ability to resize and maximize form size is supported in:
  Company Details, General Settings, Posting Periods, Print Preferences, Checks for Payment, Document Generation Wizard, Update Special Prices Globally, Trial Balance Revaluation, General Ledger, Layout and Sequence, Request for Generation Approval, Approval Stages, Export Transactions to SAP Business One, Payment Methods, Payment Terms, Query Authorization Groups, Report and Layout Manager, UDF - Field Data, Configuration Management, Cash Flow, Add-on Manager

Benefit

- Increased usability by avoiding scrolling, especially in busy forms
- Alignment with standard system form behavior
User Name in License & Add-On Administration

Feature

- A new column for displaying the *User Name* is added to the *Allocation* and *Assignment* tabs in *License Administration* window and to the *User Preferences* tab in *Add-on Administration* window.
- Filtering according to *User Name* field is now possible within both forms.
- Sorting by *User Name* is supported in the License Administration window.

Benefit

- Enhanced clarity and transparency of the user's identity by displaying the user name supports accurate license allocation and add-on administration.
Business Process Enhancements

- Change Log for Exchange Rates lists changes made in the regular client and the Web client
- Configure display mode for Employee Name
- Refresh button is enabled for Balance Sheet Comparison Report
- Support sorting for project stages
- Clear display of Company Name in minimized client window
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide Locked User</td>
<td>A new checkbox ‘Hide Locked User’ is available in the Add-on Administration, UI Configuration Template, Alerts Management, and Copy Form Settings (Users – Setup) windows. SAP Note <a href="FP2011">2970933</a></td>
<td>All</td>
</tr>
<tr>
<td>Add Queries to SAP Business One Menu</td>
<td>Queries can be added to the SAP Business One menu via the Query Manager window choosing the Assign to Menu option. In the Query Menu Registration window select the Menu Item checkbox and specify the details where this query should be positioned. The display of the query is related to the user’s authorization. SAP Note <a href="FP2011">2970958</a></td>
<td>All</td>
</tr>
<tr>
<td>Import User-Defined Tables (UDT) from Microsoft Excel</td>
<td>User-Defined Tables (UDT) can be imported from Microsoft Excel. In the Data Type to Import dropdown list the entry User-Defined Tables is available based on the UDT form authorization. SAP Note <a href="FP2011">2970949</a></td>
<td>All</td>
</tr>
</tbody>
</table>
Financial Management
SAP Business One 10.0
Drill Down to G/L Account in Financial Reports

**Feature**
- Golden arrows are added next to the account codes in financial reports allowing users to drill down into the account record within the *Chart of Accounts*
- Available in *Balance Sheet*, *Trial Balance*, and *Profit and Loss Statement*

**Benefit**
- Direct access to account details and account balance of relevant accounts increases usability and transparency
- Streamlined with standard system behavior
Posting Periods Enhancements

Feature

- A new checkbox added to the Posting Periods window enables to define the default “Due Date To” to be set when creating new posting periods
- The sorting of columns is now possible within the Posting Periods form
- Filtering is now possible within the Posting Periods form
- The Find field allows for quick free-text searching

Benefit

- Simplifies and streamlines the creation of new financial periods
- Enhanced usability of the Posting Periods table, highly significant for businesses with long list of posting periods
Extend Journal Entry Remarks to 254 Characters and Increase Length of Ref. 3 Fields

Feature

- The Remarks field in Journal Entry is extended and may contain up to 254 characters
- The length of the Ref. 3 fields in the header and rows are increased to 100 characters (FP2008)
See SAP Note 2949589

Benefit

- Allows to enter more detailed information related to the journal entry
- The alignment with Remarks field size in marketing documents fully supports setting it as reference fields, while previously, remarks >50 characters would cut-off when copied to the Remarks in Journal Entry
Period End Closing - Journal Entry Series

Requirement

- Consistent document numbering in the accounting through the same accounting period,
- French legal requirement for legal audit.

Solution

- Setting for the Journal Entry series for different accounting periods are enabled for Closing and Opening Balances in the Period End Closing Utility,
- Setting for the Journal Entry series in Exchange Rate Differences Report,
- Setting for the Journal Entry series in Conversion Differences,
- Enabled to all localizations.
- SAP Note: 3084579
Fixed Assets Enhancement

Requirements
- Specific G/L account for the Revaluation transactions of Fixed Assets should be used,
- Round fixed assets book value up or down of the whole amount.

Solution
- New Revaluation Account is introduced on Fixed Assets Account Determination,
- Default value: the same as Asset Balance Sheet Account,
- New rounding methods for the Year End Book Value.
- SAP Note: 3083952
# Financial Management

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Warn Message Before Adding Manual Journal Entries</strong></td>
<td>When adding a manual <em>Journal Entry</em> a system message appears to warn that journal entries cannot be changed after adding them. SAP Note <a href="https://support.sap.com/2923187">2923187</a> (FP2008)</td>
<td>All</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Localization</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Updating Reference Field in Journal Entries with Locked Posting Periods</td>
<td>Update of the Remarks, Ref1, Ref2, Ref3, and User-Defined Fields in journal entries with locked posting periods is enabled. SAP Note <a href="FP2011">2968895</a></td>
<td>All</td>
</tr>
</tbody>
</table>
| Bank Statement Processing (BSP) Enhancements                           | In the Bank Statement Row – Details: Expanded window, for bank statement rows whose posting method is Business Partner from/to Bank Account:  
- Distribution rules can be defined  
- Sales and purchase orders can be added using the Add Open Documents window. BSP will create down payment invoices or requests based on the orders  

In the Bank Statement Details window:  
- For bank statement rows whose posting method is Business Partner from/to Bank Account, and for which any document is selected, the control account can be defined  
- When you have selected the checkbox No Validation for Starting/Ending Balance in the House Bank Accounts - Setup window, the bank statement can be finalized even if the difference does not equal zero; and the starting balance of your current bank statement can be different to the ending balance of the previous one  

See more details in SAP Note [2980038](FP2011)                                                                                 | All          |
## Bank Statement Processing (BSP) Enhancements

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bank Statement Processing (BSP) Enhancements</td>
<td>In the <em>Bank Statement Row – Details: Expanded</em> window, the values in the <em>Applied Amt - Payment Currency</em> column can be updated.</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td>In the Bank Statement Details window, order currency can be different from the local currency.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>See more details in SAP Note <a href="https://support.sap.com/p31178">3031178 (FP2102)</a></td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Localization</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Refresh Function in Financial Reports Enabled</td>
<td>The latest refreshed report will be displayed after clicking the <em>Refresh</em> button. The refresh functionality is available for - Financials -&gt; Financial Reports -&gt; Accounting -&gt; General Ledger - Financials -&gt; Financial Reports -&gt; Accounting -&gt; G/L Accounts and Business Partner</td>
<td>All</td>
</tr>
<tr>
<td>Bank Statement Processing (BSP) Enhancements</td>
<td>When import a bank statement with multiple reference numbers with commas in between in the <code>&lt;Ustrd&gt;</code> field of the bank file, those numbers will be separated according to the commas as multiple rows in the <em>Multiple Payments</em> window. User-Defined Fields (UDFs) can be added as columns in the <em>Bank Statement Summary</em> window with the new entry <em>Bank Statement Processing – Header</em> The <em>Create Down Payment in Bank Statement Processing</em> dropdown list for sales and purchase orders on the <em>Per Document</em> tab of the <em>Document Settings</em> window is now available for the Israel localization. See more details in SAP Note 3055456 (FP2105)</td>
<td>All</td>
</tr>
</tbody>
</table>
Localization
SAP Business One 10.0
New UK (Brexit) Localization

**Feature**

- New localization introduced for *United Kingdom of Great Britain and Northern Ireland* to support post-Brexit
- In this localization *Make Tax Digital* and *Extended Tax Reporting* are set by default
- See SAP Note [2519116](#)
- *Localization Migration Utility (FP2008)* See SAP Note [2912598](#)

**Benefit**

- Smooth transition from pre-Brexit GB Localization to the new UK Localization
EU - One Stop Shop Enhancement

**Requirement**
- Reporting of the specific transactions relates to the OSS tax regime,
- Possibility to have the output in electronic format.

**Solution**
- Separate output regime available in the Tax Report,
- New Electronic File Manager mapping file created in format of print layout,
- Enabled to all EU localizations.
- SAP Note: 3143352
Mexico - Electronic Invoice CFDI 4.0 - eDoc

**Requirement**
- Enhancement of the eDocuments, ePayments/eReconciliations to version 4.0,
- Adjustment in the electronic documents cancellation process
- Mexican legal requirement for eDocuments processing.

**Solution**
- New parameters added to Business Partner Master data and document level,
- Enhancements of the Electronic File Manager mapping files for eDocuments and ePayments/eReconciliations,
- Enhancements of the eDocuments cancellation process
- Enabled to MX localization.
- SAP Note: [3129890](http://example.com/3129890)
India Localization Enhancements

**Requirements**
- E Way Bill enhancement: default values, protocol setup
- E Bill enhancement: default protocol for the BP
- Higher TDS/TCS Rate

**Solution**
- Default values in E Way Bill form, User Query Category is added to the protocol setup, HSN fields are exposed in DI API
  - SAP Note: 3147725
- E Bill protocol can be set in BP master Data
  - SAP Note: 3147739
- New rates are added to the Withholding Tax setup, in case P.A.N/ITR are not set, the higher rate will be used,
  - SAP Note: 3142500
Japan - Qualified Invoice Method

Requirement

- Tax calculation on documents to be done per specific Tax Code.
- Amounts visualized per Tax Code on the form as well as in a new Print Layout.
- Monthly Invoice to follow the same rules and create correction entry if needed.

Solution

- Tax Details calculated per Tax Code provided under link from Marketing Document header.
- New Print Layouts for Marketing Documents and Monthly Invoice containing Tax Details.
- Monthly Invoice recalculates Taxes by Tax Code and creates an adjustment transaction if needed.
- Further enhancements related to Monthly Invoice.
- See SAP Note 3143362 for more details.
Argentina - Withholding Tax (Perception) in the Automatic Credit Memo

FP2202 Update

Requirements
- There should be a possibility to set withholding tax (perception) in that way that it will not be calculated in the automatic credit memo

Solution
- New setting in the Withholding Tax – Setup window,
- In case the new setting is ticked off the tax is not determined in the automatic Credit Memo created by Payment,
- SAP Note: 3151644
Items Country of Origin Tracing (EU)

Requirement
- Manage Items Country of Origin for proper reporting in the Intrastat

Solution
- Enable assigning Country of Origins to Intrastat relevant items in the Marketing Documents lines
- Track Items Country of Origin by quantity in all documents
- Enhance Intrastat report with information from Country of Origin Assignment
- Enabled to all EU localizations
- SAP Note: 3223246
New Tax Service with Avalara’s Tax Rates by Address (US)  

**Requirement**

- In 2021, SAP internally announced its intention to sunset SAP Localization Hub Tax Service – this procedure is in process in 2022.
- SAP Business One customers can still use current SAP’s service till November 30, 2022
- Replacement of the sunset online tax service needs to be introduced to provide similar experience and functionality

**Solution**

- New Tax Service provider – Avalara supported with API service “Rates by Address” which provides valuable and free-or-charge service
- Out-of-box integration to Avalara API service through EDS
- New Electronic Documents Service connector added for Avalara integration
- Usage of Avalara tax service on marketing documents identical to usage of SAP’s tax service
- SAP Note [3194512](#)
API Tax Enhancements - Service Layer & DI API (BR)

Requirement / Solution

- External calculation of taxes to be allowed on A/P side similarly as on A/R side
- Tax Code Determination in Brazil localization exposed via Service Layer / DI API
- Tax fields from INV4 table exposed via SL / DI API (Base Tributada, Aliquota, Valor Tributável, Valor Insentas, etc.)

Benefits

- Support SSPs with enhanced extensions on advanced Brazil tax functionality and foster strategic deals
- Support customers with additional scenarios through partner extensions
- SAP Notes 3227386, 3227700 and 3224708

FP2208 Update
Legal Compliance Enhancements (FR)

Requirements:
- Track Items/Service description in Marketing Document Chain
- Control Tax codes for Line Freights
- Post tax in the payment of Down Payment Invoice
- Legal reports enhancement.

Solution:
- New check box in Document Settings for blocking Item/Service description in the document chain, all loc
- System message with autosave option checking tax codes introduced, all loc
- New check box in Document Settings for deferred tax to be used in Down Payment Invoice as a default value for this document, FR loc
- Period status information is added to the Financials report layouts, FR loc.
- SAP Notes: 3234669, 3235565, 3237837, 3237883
CFDI 4.0 Enhancements (MX)

**Requirement**
- When using "Request Cancel" functionality, it is not possible to specify "Cancellation Reason" field
- Additional changes to Electronic File Manager mapping files for Documents, Payments and Reconciliations
- Non-tax attribute to be considered for the exported documents
- Legal change due date was delayed to Jan 1, 2023.

**Solution**
- Solution for the reported feedback and updated mapping file
- SAP Note 3237267
- SAP Note 3207993
With the new checkbox Enable Applying Non-deductible Purchase Tax on Expense Account you can now manage different deducted purchase tax in one A/P document, per row.

This working method allows you purchase different items with different deducted purchase tax in the same purchasing document. For example, items you are only allowed to deduct 2/3 or 1/4 of the tax %, as defined by the Israel Tax Authority. For more information, see SAP Note 3235805

*This is the current state of planning and may be changed by SAP at any time.
You can now send your marketing documents for digital signature process. SAP Business One sends the document in a PDF file to a third-party server, called Comsign, and gets back a signed document.

For more information, see SAP Note [3310648](#).

*This is the current state of planning and may be changed by SAP at any time.*
E-Book Stamp Duty enhancements (GR)

**Requirement**
- One-to-one mapping between the items of the issuer's myDATA invoice and the recipient's expense classification, IAPR (AADE) introduced a new method to submit the expense classifications per invoice logic in Feb of 2023;
- The new way of handling matched expenses is based on updated schema of ExpensesClassificationsDoc XML v1.0.6 and is switched on by a new parameter in the call of API method `sendExpensesClassification`

**Solution**
- New fields in the marketing documents Record Type/Stamp Duty/Other Taxes/Fees with valid values are introduced;
- New schemas are included;
- For more information, see SAP Note 3290165.
India – eTDS & Down Payment Request

Requirement
- TDS should be deducted at the time of payment or invoice – whichever is earlier.

Solution
- TDS can be assigned in the A/P Down Payment Request;
- Once the request is selected for the payment the TDS is deducted;
- For more information, see SAP Notes 3311856, 3288719.
AR – Fixed Assets Transfer & Generic Enhancements

Requirements
- AR: Fixed Asset physical transfer to be included to the transportation document
- All: Landed Cost to affect Fixed Assets
- All: Journal Entry numbering series selection in the depreciation run

Solution
- AR: new tab in the Transfer
- AR: new document in the Transportation Document
- Automatic Capitalization for the Landed Cost
- New Numbering Series for the Depreciation Run
- Print possibility for all Fixed Assets transactions documents
- Project and Distribution Rules fields are added to all Fixed Assets transaction documents
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>„Country“ Field Labels Changed to „Country/Region“</td>
<td><em>Country</em> field labels are changed to <em>Country/Region</em>. SAP Note <a href="FP2102">3021987</a></td>
<td>All</td>
</tr>
<tr>
<td>Country/Region Setup Enhancements to Support ISO 3166 Country Codes</td>
<td>The <em>Country/Region</em> fields are populated based on the official ISO 3166 country codes in the <em>Countries/Regions – Setup</em> window. SAP Note <a href="FP2102">3019691</a></td>
<td>All</td>
</tr>
</tbody>
</table>
## Localization

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>GDPR and Classification of Data in Personal Data Management</strong></td>
<td>Multiple data fields are classified as <em>Personal</em> or <em>Sensitive Personal</em> and available for selection in <em>Personal Data Management</em> (Administration → Utilities → Data Protection Tool → Personal Data Management). See details in SAP Note <a href="http://example.com">3031723</a> (FP2105)</td>
<td>All</td>
</tr>
</tbody>
</table>
Sales | Purchasing | Service
SAP Business One 10.0
Backorder Report Enhancements

**Feature**
- **Backorder Report** now displays A/R Reserve Invoices with payment status Fully Paid, Partially Paid and Not Paid
- Reserve Invoice Payment Status is included within the Filter Table

**Benefit**
- All A/R Reserve Invoices are visible within the Backorder Report
Printing Service Calls and Contracts

Feature

- **Print Preferences** are now available for both Service Calls and Service Contracts
- **Document Printing** includes Service Calls and Service Contract allowing for bulk document distribution

Benefit

- Preference settings on Service Calls and Service Contract printing/emailing
- Bulk processing of service calls and service contracts
Hide Blank Lines in Addresses

**Feature**

- A new checkbox within the Address Formats - Setup window allows the hiding of empty address lines
- When selected, ship-to and bill-to addresses in future marketing documents appears without empty lines
- This setting also applies to print layouts for marketing documents defined in Crystal Reports – i.e. empty lines in addresses will also be hidden in the printed documents

**Benefit**

- Enhanced formatting of the printed, previewed, or PDF document
- Easier readability for users within marketing document forms, especially when address format consists of multiple components
Add Button Extended in Marketing Documents
SAP Note 2878515

Feature
- The Add button in sales and purchase document creation is enhanced
- Additionally to the previous common behavior (i.e. after creating and adding a document, the window closes and a new window opens), the following options are now available:
  - Add & New: Document is added and a new window opens
  - Add & View: Document is added and is displayed
  - Add & Close: Document is added and window closes
- The user’s last choice will be remembered for the given document for the next time

Benefit
- More flexibility in document creation and better handling for users
Enhanced Open Items List Report
SAP Note 2878483

Feature

- The Open Items List report includes more document information: Owner, Sales Employee/Buyer, Remarks, Approved, Created by, Contact Person, Payment Terms, BP Project, UDFs in document headers

- The report offers the possibility to close and cancel multiple documents. This feature is supported for these document types: Sales Quotation, Sales Order, Purchase Request, Purchase Quotation, Purchase Order

- In the report multiple Return Requests and Goods Return Request documents can be closed

Benefit

- Easier handling due to more document options and information in one report
EU PEPPOL E-Invoicing

Feature

- International electronic invoicing platform with a set of rules and specifications that enables electronic communications with any European government institution for procurement processes.
- Electronic documents are sent and received through registered service providers.
- See more details and local specifics for PEPPOL protocol in SAP Note [2915144](https://support.sap.com/).
- General information on PEPPOL integration for the EU in SAP Note [2669994](https://support.sap.com/).
- Due to own specific electronic invoicing functionality, following localizations don’t support PEPPOL at that time: Argentina, Brazil, Costa Rica, Guatemala, India, and Mexico.

Benefit

- Creation and import of documents in electronic format.
SAP Business One Sales and Service Mobile Apps
Supported on MS SQL with FP 2105 + App Updates released for iOS + Android updates to come soon

- **SAP Business One Sales mobile app** for iOS or Android helps manage sales leads, customer accounts, view stock, and place an order.

- With SAP Business One **Service mobile app** for iOS or Android, maintenance technicians can provide on-site services for their customers easily and efficiently.

- With FP 2105, support for MS SQL databases is enabled. A few HANA-related capabilities are not available with SQL.

- Key updates for both apps on iOS released on August 7th, 2021.

- Key updates for both apps on Android were released on August 23rd, 2021.
Sales and purchase quotations, are enhanced with the checkbox “Confirmed” to the “Logistics” tab, and in “Document Settings” > “Per Document” tab accordingly. When selected, a tooltip shows the user and time of confirmation.

The “Open Items List” report for sales and purchase orders, return and goods return requests is enhanced with dedicated columns presenting confirmation date and user details.

The “Move Up” and “Move Down” buttons are available in sales and purchasing documents, enabling you to change the sequence of lines.

The procurement process is enhanced to apply tax code determination rules to purchase requests created manually or via “Procurement Confirmation Wizard”, and purchase quotations and orders created directly or through purchase request reports.
Business Process Enhancements

- Copying opening and closing remarks
- Add settings to copy reference documents when duplicating
- Update user-defined fields in closed pick lists
- Copy an open landed costs after creating a broker invoice
### Feature

<table>
<thead>
<tr>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Editing UDFs in Document Rows</strong>&lt;br&gt;After the Document was Added or Closed</td>
<td>All</td>
</tr>
<tr>
<td>A new setting in the Document Settings &quot;Allow Update of User-Defined Fields When Document Rows Are Not Editable&quot; gives the possibility to make UDFs editable independently of the document/row status. New authorization controls user's ability to edit UDFs on marketing document rows. SAP Note <a href="http://2872368">2872368</a> (PL01)</td>
<td>All</td>
</tr>
<tr>
<td><strong>Display Business Partner Address UDF with Marketing Document</strong>&lt;br&gt;Address User Defined Fields</td>
<td>All</td>
</tr>
<tr>
<td>Business Partners – Addresses UDFs can be viewed and updated in&lt;br&gt;• Address Component window on Logistics tab in marketing documents&lt;br&gt;• Address Component window on Business Partner tab of Service Calls&lt;br&gt;• Address Formats – Setup window&lt;br&gt;See the Compatibility Issues in SAP Business One 10.0 SAP Note <a href="http://2872353">2872353</a> (PL01)</td>
<td>All</td>
</tr>
</tbody>
</table>
## Create QR Codes
QR (Quick Response) codes can be created on print layouts of marketing documents. New field **Create QR Code From** is available in **Accounting** tab of marketing documents. An API service and a free open source library are available for partners to create QR codes.

SAP Note [2889899](http://example.com) (PL02)

### Localization
All

## Adding Multiple Business Partners to One Equipment Card
Multiple business partners can be added to an equipment card.

SAP Note [2906168](http://example.com) (PL02)

### Localization
All

## Updating Group Number
The Group No. on purchase quotations can be changed to the next sequential number in the predefined series.

SAP Note [2896569](http://example.com) (PL02)

### Localization
All
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copying Manual Remarks</td>
<td>Under Administration → System Initialization → Document Settings → General tab → Document Remarks Include section a new option Manual Remarks Only is available. With this option, when using ‘Copy To’ to copy a base sales, purchasing or inventory document, the ‘Remarks’ field in the target document will only include the remarks entered by users in the source document, excluding the 'Base Document Number' or the 'Business Partner Reference Number'. SAP Note 2931961 (FP2008)</td>
<td>All</td>
</tr>
<tr>
<td>Copy Attachments from Base Document to Target Document</td>
<td>Under Administration → System Initialization → Document Settings → General tab enable checkbox ‘Attachments from Base Document to Target Document’ to copy documents attachments. SAP Note 2923323 (FP2008)</td>
<td>All</td>
</tr>
<tr>
<td>Item Description is Exposed in Alternative Items Window</td>
<td>The column Item Description is exposed in the Alternative Items window. SAP Note 2955529 (FP2008)</td>
<td>All</td>
</tr>
<tr>
<td>New Checkbox ‘Duplicate Bar Codes While Duplicating Items’</td>
<td>A new checkbox Duplicate Bar Codes While Duplicating Items available under Administration → System Initialization → General Settings → Inventory → Item tab. SAP Note 2928480 (FP2008)</td>
<td>All</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Localization</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Document Status “E-Mailed”</td>
<td>Display status ‘Open; E-Mailed’ and ‘Open; Printed and E-Mailed’ in sales documents, purchase documents, and inventory transfer requests when the document was sent by e-mail. SAP Note <a href="https://support.sap.com">2924241</a> (FP2008)</td>
<td>All</td>
</tr>
<tr>
<td>Recurring Transaction Templates Selection Criteria Window</td>
<td>When opening the ‘Recurring Transaction Templates’ the ‘Selection Criteria’ window opens to filter the templates. SAP Note <a href="https://support.sap.com">2939185</a> (FP2008)</td>
<td>All</td>
</tr>
<tr>
<td>Recurring Transaction Templates Recurrence Period Enhancement</td>
<td>‘Recurrence Period in Recurrence Transaction Templates’ supports the options ‘Every 2 Weeks’ and ‘Every 2 Months’. SAP Note <a href="https://support.sap.com">2939183</a> (FP2008)</td>
<td>All</td>
</tr>
<tr>
<td>Consider Prices Before Discount Group as Effective Price</td>
<td>Consider prices before discount group as effective price when adding marketing documents. SAP Note <a href="https://support.sap.com">2905325</a> (FP2008)</td>
<td>All</td>
</tr>
<tr>
<td>Cancelation of Return Request and Goods Return Request</td>
<td>‘Return Request’ and ‘Goods Return Request’ can be canceled. SAP Note <a href="https://support.sap.com">2928911</a> (FP2008)</td>
<td>All</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Localization</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
<td>--------------</td>
</tr>
</tbody>
</table>
| **Update Consolidating Business Partner and Consolidation Type on Document Level** | View and update the consolidation business partner and consolidation type on the *Accounting* tab is enabled. The default values are taken from the business partner master data and values cannot be changed after the documents are added. This is enabled for the following documents:  
- A/R Invoice, A/R Reserve Invoice, A/R Credit Memo, A/R Down Payment Invoice (all localizations except CZ, SK, HU, PL, RU, UA)  
  Delivery, Return  
- A/P Invoice, A/P Reserve Invoice, A/P Credit Memo, A/P Down Payment Invoice (all localizations except CZ, SK, HU, PL, RU, UA), Goods Receipt PO, Goods Return | All |

The consolidating business partner and consolidation type of the documents generated with the following tools and methods are taken from the base documents and not from the business partner master data:  
- Document Generation Wizard  
- Payment Wizard  
- Billing Wizard  
- Copy to  
- Copy From  

SAP Note [2980002](https://support.sap.com) *(FP2011)*
## Feature

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
</table>
| Items Associated with Canceled Procurement Documents are Displayed in the Procurement Confirmation Wizard | Items in a sales order / sales quotation / production order associated with canceled procurement documents are displayed in the Procurement Confirmation Wizard  
SAP Note [1804907](FP2102)  
SAP Note [3007312](FP2102)  
SAP Note [3009497](FP2102)  | All                                                                                                                                         |
| Set Default Business Partner Catalog Number                             | On the BP tab or the Items tab in the Business Partner Catalog Numbers window a user can select a Business Partner Catalog Number as the default for each item from the BP tab, or for each business partner from the Items tab.  
SAP Note [1804907](FP2102)  
SAP Note [3007312](FP2102)  
SAP Note [3009497](FP2102)  | All                                                                                                                                         |
| Hide Inactive Contact Person in Business Partner Master Data            | A new checkbox Display Inactive Contact Persons in Business Partners Master Data is added to the General Settings → BP tab.  
This checkbox can be used to determine whether to display inactive contact persons on the Business Partner Master Data → Contact Persons tab.  
SAP Note [1804907](FP2102)  
SAP Note [3007312](FP2102)  
SAP Note [3009497](FP2102)  | All                                                                                                                                         |
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
</table>
| Link Between Contact Persons and Business Partner's Addresses | With the new dropdown list Connected Address on the Contact Persons tab of the Business Partner Master Data, it is possible to link the business partner’s existing  
- Bill to  
- Pay to  
- Ship to  
address to the selected contact person. SAP Note [2979550](https://www.sap.com) (FP2102) | All          |
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Referenced Documents Displayed in Document Tree View in Relationship Map</td>
<td>The relationship of referenced documents is displayed in the Marketing Document: Referenced Documents view and in the Marketing Document: Document Tree view. SAP Note 3050215 (FP2105)</td>
<td>All</td>
</tr>
<tr>
<td>Set Default Price List in General Settings instead of in Payment Terms</td>
<td>A new checkbox Set Default Price List in General Settings instead of Payment Terms is available (Administration -&gt; System Initialization -&gt; General Settings -&gt; BP tab) where the default price lists for customers and vendors can be set and in doing so stop using the price list setting in the Payment Terms - Setup. See details in SAP Note 3047725 (FP2105)</td>
<td>All</td>
</tr>
</tbody>
</table>
Project Management
SAP Business One 10.0
Interactive Gantt Chart

**Feature**
- Interactive Gantt Chart allows Project Phases to be moved or extended/shortened interactively.
- New fields added representing Project Due Date and Finish Date.

**Benefit**
- Project updated according to planning changes within interactive Gantt Chart.
- Easier and more visual planning of Project Management Tasks.
Serial & Batch Numbers Management

Feature

- **Serial Number Management and Batch Management** now includes the ability to update on **A/R Reserve Invoices** and **Inventory Transfer Requests**
- **Destination Warehouse Code and Destination Warehouse Name** now included in the **Serial Number / Batch Management Update** form
- New reports available (PL01):
  - Forward Batches and Serials Trace Report
  - Reverse Batches and Serials Trace Report
  - See SAP Note 2877541

Benefit

- More document options when updating Serial Numbers and Batches
- Better reporting on warehouse code on warehouse name on inventory transfer transactions
Support Changing UoM Group in Item Master Data

Feature

- **Unit of Measure Groups** may now be changed on an *Item Master Data* record
- To do this the new UoM Group must have at least the identical set of conversion rules as the original UoM Group
- Only need to “zero down”/close open documents on changed item UoM Groups definitions
- Set UoM in its *UoM Group* to *Active* *(PL01)*
  See SAP Note 2878890

Benefit

- More flexibility in changing UoM group relationships for Item Master data
## Inventory | Distribution

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Prices Report in Item Master Data</td>
<td><em>Last Prices Report</em> can be opened in the <em>Item Master Data</em> window. SAP Note <a href="#">2979973</a> (FP2011)</td>
<td>All</td>
</tr>
<tr>
<td>Display Preferred Vendor Name in Item Master Data</td>
<td>The <em>Preferred Vendor Name</em> is displayed in the <em>Item Master Data</em> -&gt; <em>Purchasing Data</em> tab. SAP Note <a href="#">2970897</a> (FP2011)</td>
<td>All</td>
</tr>
<tr>
<td>Sales/Purchase Item in Item Master Data can be Deselected</td>
<td>When an item that is a component of another item in a bill of material (BOM) the option <em>Sales Item</em> or <em>Purchase Item</em> can be deselected. SAP Note <a href="#">1329054</a> (FP2011)</td>
<td>All</td>
</tr>
</tbody>
</table>

FP2011 Update
# Inventory | Distribution

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>QR Codes for Item Master Data</td>
<td>New field <em>Create QR Code From</em> is available in the <em>Item Master Data</em>. SAP Note <a href="https://support.sap.com/3060959">3060959</a> (FP2105)</td>
<td>All</td>
</tr>
</tbody>
</table>

FP2105 Update
Production
SAP Business One 10.0
Bill of Materials (BoM) Description Enhancements

**Feature**

- Item Description update in the item master data connected to Bill of Materials parent item will be reflected in the Bill of Materials Product Description
- The item and resource descriptions are editable in Bill of Materials and Production Order Components. Additionally, the Item Description can be updated via DI API (PL01)
  
  See SAP Note [2872529](https://support.sap.com/)

**Benefit**

- Item master data record descriptions updated accordingly within the associated Bill of Materials
- Flexible handling of item and resource descriptions in Bill of Materials
Drill Down from BoM to Item Master Data

**Feature**
- Direct “drill-down” to Item Master Data record now possible from the Parent Item Number

**Benefit**
- More intuitive and direct navigation between Bill of Materials and Item Master Data
- Flexibility within navigation due to system prompt of navigation choice
## Production

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Production Orders as Base Document in Procurement Confirmation Wizard</td>
<td><em>Production Order</em> can be selected as <em>Base Document</em> in the <em>Procurement Confirmation Wizard</em>. &lt;br&gt;SAP Note <a href="FP2008">2945172</a></td>
<td>All</td>
</tr>
<tr>
<td>Edit Closed or Canceled Production Orders</td>
<td>When a <em>Production Order</em> is closed or canceled, the following fields will be editable:  &lt;br&gt;- <em>Remarks</em> on the form footer  &lt;br&gt;- <em>Pick and Pack Remarks</em> on the form footer  &lt;br&gt;- <em>Reference Document</em> on the <em>Summary</em> tab  &lt;br&gt;- <em>Attachments</em> on the <em>Attachments</em> tab  &lt;br&gt;- <em>User-Defined Fields</em> on <em>Production Order – Title</em> and on <em>Production Order - Rows</em> &lt;br&gt;SAP Note <a href="FP2008">2920833</a></td>
<td>All</td>
</tr>
<tr>
<td>Delete Bill of Materials (BOM) en Masse</td>
<td><em>Bill of Materials</em> (BOM) can be deleted en masse from <em>Bill of Materials Management</em>. &lt;br&gt;SAP Note <a href="FP2008">2926091</a></td>
<td>All</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Localization</td>
</tr>
<tr>
<td>----------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Hidden BOM Components are Not Printed on SAP Crystal Reports</td>
<td>Defined 'Hide BOM Components in Printout' are not printed using SAP Crystal Report layouts. SAP Note <a href="FP2102">2319313</a></td>
<td>All</td>
</tr>
</tbody>
</table>
Platform | Extensibility
SAP Business One 10.0
Service Layer Enabled for Microsoft SQL Server

**Feature**
- Built on core protocols such as HTTP and OData
- Highly scalable (parallel-processing)
- High availability (load balancing)

**Benefit**
- Ready for loosely coupled extensibility running for MSSQL and HANA
Service Layer Configuration UI

Feature

- New System Landscape Directory URL for Service Layer configuration
- https://<hana-server>:<sld-port>/ServiceLayerController

Benefits

- No need to edit multiple configuration files
Formatted Search Supports Multiple Triggers

**Feature**
- **User Define Values** support multiple triggers

**Benefit**
- More possibilities and flexibility when implementing formatted searches/user defined values
Extend UDF Support to Additional Objects

Feature

- **User Defined Fields** can be added to more SAP Business One 10.0 objects*

  *Alerts (OALT), Attachment rows (ATC1), Countries (OCRY), Document Numbering Series (NNM1), BP Groups (OCRG), BP Payment Terms (OCTG), BP/Item Properties (OCQG)/(OITG), Item Preferred Vendors (ITM2), Item Prices (ITM1), Manufacturers (OMRC), UoM Master Data (OUOM), Location (OLCT), Package Types (OPKG), Branch Setup (OBPL), and Shipping Types (OSHP)

Benefit

- More possibilities in quick solution customizing
Gatekeeper (Browser Access) Service

Feature
- SAP Business One Client UI is rendered and published via gatekeeper service over the HTTPS protocol

Benefit
- Easy access
- No local client is needed
Microsoft Office 365 Integration

Feature
- **Microsoft Office 365** and **OneDrive** integration allows for document layouts, grid results and reports to be exported into Excel and Word accordingly
- **SAP Business One 10.0 Template Management** allows for more flexibility in reporting and document layouts management
- **Microsoft Office 365** integration starting with **SAP Business One Cloud 1.1 PL17 (FP2102)**
  See SAP Note 3018885

Benefit
- Automatic upload of exports into OneDrive
- Easier report and document layouts management
- Access from everywhere
Document Information Extraction

Feature
- Scanning PDF documents and extract invoice header and item information
- Create A/P invoice in SAP Business One
- See SAP Note 3021904

Benefit
- Automatic generation of A/P invoice drafts out of PDFs
- Let employees save work time and focus on new activities
64-bit Only Support

Feature
- SAP Business One will support only 64-bit Windows operating system
- Only 64-bit add-ons will be supported with SAP Business One 10.0

Benefit
- Smaller software package downloads (due to removal of redundant 32-bit executables)
Extensibility Enhancements

- Service Layer Controller is enhanced to support the Service Layer log monitor with the following functionalities:
  - Show normal requests
  - Show error requests
  - Show detail logging
Identity and Authentication Management (IAM)
Sign in to SAP Business One and supported components with your Identity Provider* user

- Single sign-on (SSO) experience
- Enhanced security and reducing potential attack surface
- One stop shop for user management actions across B1 company databases
- No need to remember multiple passwords

FP 2208 Enables You to Sign in Using IAM to the Following Components:

- SAP Business One Desktop Client
- SAP Business One Web Client
- System Landscape Directory
- License Service
- Service Layer
- DI API
- Extension Manager
- Job Service
- Mobile Service (except for touch ID for Android)
- Analytics Platform
- API Gateway Service
- Outlook Integration Server
- Excel Report and Interactive Analysis
- Data Transfer Workbench (DTW)
- Microsoft 365 Integration

⚠️ In FP 2208, the IAM service is not supported by the corresponding SAP Business One Cloud version; This is planned for future SAP Business One Cloud versions

*With FP 2208, it is possible to register only AD FS or Azure Active Directory as external identity providers in OIDC
IAM Enhancements

IAM Functionality

- Two-Factor Authentication – introducing 2FA within SAP Business One authentication service
- Supporting Okta and SAP IAS as OIDC Identity Providers
- Supporting Single Logout - the identity provider logs you out of all SAP Business One Web-based pages in the current identity provider login session in the same Web browser
- Additional SAP Business one components to support IAM. For more information about components supported by IAM in SAP Business One, see SAP Note 3252125

Sign in

- The localization and version information are visible in the Choose Company window when you log into SAP Business One client, mobile service and IMCC
- When you log into SAP Business One client, the company that you log in last time is selected by default in the Choose Company window
- Introducing “Change password” option on the login page when you log into SAP Business One with the bound user account

User Binding

- Bind users from SAP Business One Client
- Multiple company user binding - select more than one company when binding an IDP user to a same company user
- Enhanced UX - when binding an IDP user to a company user code, if the user code is newly defined for all selected companies, the label (New) shows after the user code. The default user code is the IDP user name

Cloud & Extensions

- Log into Service Layer with a Windows domain user account after activating Active Directory Domain Services and binding its users to company users.
- Next Cloud release will support deployment of FP 2208 (without IAM)
- Future Cloud release will introduce IAM support for SAP Business One systems hosted via Cloud Control Center
## Platform & Extensibility

See also the SAP Business One Platform Support Matrix (MS SQL / SAP HANA)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP HANA 2.0 Platform Adaption</td>
<td>SAP HANA 2.0 supported only</td>
<td>All</td>
</tr>
<tr>
<td>Support SLES 15</td>
<td>Suse Linux Enterprise Server SLES 15 only</td>
<td>All</td>
</tr>
<tr>
<td>SAP HANA 2.0 Platform Adaption for Remote Support Platform 3.2</td>
<td>RSP 3.2 supports SAP HANA 2.0</td>
<td>All</td>
</tr>
<tr>
<td>Integration Framework for SAP Business One</td>
<td>Additional System Types in System Landscape Directory available: SAP Business One 10.0 SAP Business One Generic S/4 HANA on Premise SAP Note 2857220</td>
<td>All</td>
</tr>
<tr>
<td>SAP Business One integration for SAP NetWeaver</td>
<td>New checkbox Allow to Update Address ID added to the Administration -&gt; System Initialization -&gt; General Settings -&gt; BP tab. This checkbox is selected by default. When deselecting the checkbox the Address ID field cannot be edited and updated through DI API; an error message appears.</td>
<td>All</td>
</tr>
<tr>
<td>DI API: Blocking Updating Address ID in Business Partner Master Data through DI API</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Localization</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>DI API and Service Layer:</td>
<td>Recurring Postings exposed to DI API and Service Layer</td>
<td>All</td>
</tr>
<tr>
<td>Recurring Postings</td>
<td>SAP Note 2878517 (PL01)</td>
<td></td>
</tr>
<tr>
<td>DI API and Service Layer:</td>
<td>Posting Templates exposed to DI API and Service Layer</td>
<td>All</td>
</tr>
<tr>
<td>Posting Template</td>
<td>SAP Note 2878484 (PL01)</td>
<td></td>
</tr>
<tr>
<td>DI API and Service Layer:</td>
<td>New methods added to cancel and restore Approval Requests in DI API</td>
<td>All</td>
</tr>
<tr>
<td>Cancel and Restore Approval</td>
<td>and Service Layer</td>
<td></td>
</tr>
<tr>
<td>Requests</td>
<td>SAP Note 2859177 (PL01)</td>
<td></td>
</tr>
<tr>
<td>DI API:</td>
<td>Additional document referencing for</td>
<td>All</td>
</tr>
<tr>
<td>Additional Reference Documents</td>
<td>Goods Receipt, Goods Issue, Purchase Request, Inventory Transfer,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Inventory Transfer Request, Inventory Transfer Request, Checks for Payment</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SAP Note 2866114 (PL01)</td>
<td></td>
</tr>
</tbody>
</table>
## Feature & Extensibility

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>MS SQL Server 2019</strong></td>
<td>SAP Business One supports Microsoft SQL Server 2019&lt;br&gt;SAP Note <a href="PL02">2877473</a></td>
<td>All</td>
</tr>
<tr>
<td><strong>Service Layer: Supports SQL View Exposure</strong></td>
<td>Service Layer on Microsoft SQL can discover and expose regular customized SQL views in OData V3/V4 protocol&lt;br&gt;SAP Note <a href="PL02">2912563</a></td>
<td>All</td>
</tr>
<tr>
<td><strong>Service Layer: Configuration Controller</strong></td>
<td>Configuration Controller for Service Layer is available, providing a user-friendly interface to update configuration parameters.&lt;br&gt;SAP Note <a href="PL02">2912506</a></td>
<td>All</td>
</tr>
<tr>
<td><strong>API Gateway</strong></td>
<td>API Gateway is available to access business data with a unified service endpoint, providing a one-time authentication to access Crystal Reports.&lt;br&gt;SAP Note <a href="PL02">2890290</a>&lt;br&gt;See <a href="#">What's New</a> in SAP Business One 10.0</td>
<td>All</td>
</tr>
<tr>
<td><strong>SAP Crystal Reports 2016 SP7</strong></td>
<td>SAP Crystal Reports 2016 SP7, version for the SAP Business One application is available&lt;br&gt;SAP Note <a href="PL02">2584094</a></td>
<td>All</td>
</tr>
</tbody>
</table>
# Platform & Extensibility

## Feature Description

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linking UDF on UDT to System Objects and UDO</td>
<td>An UDF on a system form can be linked to a system form, user-defined table (UDT), or a user-defined object (UDO). SAP Note <a href="FP2008">2949633</a></td>
<td>All</td>
</tr>
</tbody>
</table>
| Service Layer and DI API: More Properties in SalesPersons Object for Sales Employee Exposed | The following properties of the SalesPersons object (database table OSLP) are available in the DI API and Service Layer:  
- Telephone  
- Mobil  
- Fax  
- Email  
SAP Note [2932743](FP2008)                                                                 | All          |
SAP Note [2936980](FP2008)                                                                                                               | All          |
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security Certificates Enhancements for Lightweight Extensions</td>
<td>Trusted certificate for add-ons running in the landscape is needed. The add-on security mechanism will verify registered add-ons. SAP Note 2979022 (FP2011)</td>
<td>All</td>
</tr>
<tr>
<td>Service Layer: GetAddressFormat and GetFullAddress Exposed</td>
<td>In the Service Layer GetAddressFormat and GetFullAddress exposed as new AddressService. SAP Note 2990130 (FP2011)</td>
<td>All</td>
</tr>
<tr>
<td>Service Layer: Supports SQL Query</td>
<td>The Service Layer on Microsoft SQL Server and SAP HANA supports SQL Query to enhance the query capability of the Service Layer and to reduce manual effort to deploy views. SAP Note 2970896 (FP2011)</td>
<td>All</td>
</tr>
<tr>
<td>Service Layer: JavaScript Extension Works with oData Version 4.0</td>
<td>JavaScript Extension works with oData Version 4.0 in Service Layer. SAP Note 2959007 (FP2011)</td>
<td>All</td>
</tr>
<tr>
<td>Service Layer and DI API: Holiday Dates Exposed</td>
<td>Holiday date objects are exposed through Service Layer and DI API. SAP Note 2970998 (FP2011)</td>
<td>All</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Localization</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td><strong>DI API:</strong> Insert Rows at any Place in Production Order</td>
<td>Insert rows at any place within the <em>Production Order</em> grid via the DI API. SAP Note [2985713 (FP2011)]</td>
<td>All</td>
</tr>
<tr>
<td><strong>DI API:</strong> License Check Function Exposed</td>
<td><em>SBObob.GetLicenseStatus</em> is exposed on the DI API to be able to find out whether a user has a license to access a form. SAP Note [2970960 (FP2011)]</td>
<td>All</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Localization</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
<td>--------------</td>
</tr>
</tbody>
</table>
| Set Default Layouts for Documents/Reports and Printing Sequences in Report and Layout Manager | The report and layout manager has been enhanced to set the following defaults directly in the report and layout manager:  
- Set default layouts for each type of document/report  
- Set default layouts for printing sequences  
- Set a system layout as inactive  
SAP Note 3024856 (FP2102) | All |
| Document Information Extraction Service | Document Information Extraction is a service (API) from SAP that automatically reads and extracts information from digital document files and scanned documents.  
SAP Note 3021904 (FP2102) | All |
| Service Layer and DI API: Support UserSign of Documents | The UserSign property is available to identify documents based on the user who created them. This allows to filter and search for documents based on the creator.  
SAP Note 3003222 (FP2102) | All |
| Service Layer: Query Supports User-Defined Tables (UDTs) | The Service Layer SQL Queries supports User-Defined Tables (UDTs).  
SAP Note 3009505 (FP2102) | All |
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User-Defined Fields Link to Sales Persons (OSLP)</strong></td>
<td>When creating User-Defined Fields (UDFs), the <em>Linked to Entities</em> function can be used to link the UDF to Sales Persons (DB table: OSLP). SAP Note <a href="FP2102">3003178</a></td>
<td>All</td>
</tr>
<tr>
<td><strong>Retrieve Current Logged User in User Query</strong></td>
<td>In the SQL statement of an SAP Business One user query a new parameter <code>$[USER]</code> is available which reads out the ID of the current logged user. This parameter can be used to track the current user. SAP Note <a href="FP2102">3009652</a></td>
<td>All</td>
</tr>
</tbody>
</table>
Thank you.

Contact information: